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G-Standaard data entry web portal 
This “Quick start guide G-Standaard data entry web portal” offers a succinct 
description of how the G-Standaard data entry web portal works. Your products are 
added to the G-Standaard via this web portal. The information on your products 
subsequently reaches all the prescription, delivery and ordering systems in the Dutch 
healthcare market via G-Standaard's monthly production cycle and software houses. 
 
Maintaining products manually or via the upload/download feature 

• If you want to enter or change one or more articles, follow the steps in  
part 1: Article maintenance.  

•  If you want to enter or change several articles at the same time, follow the 
steps in part 2: Up/download functionality. 

Click the button at the bottom right of the article overview or go of via  
www.z-index.nl  >  Documentatie  >  Handleidingen to view all the sources of 
information.  
 

G-Standaard production schedule 
During your article maintenance, take into account the closing periods for 
new registrations and changes mentioned in the G-Standaard production 
schedule! This is important: if you miss a deadline, your new article or 
change will not be included in the G-Standard.  
See www.z-index.nl  -> Actueel -> Productieschema. 
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Logging in 
Go to www.z-index.nl and click the “Log in” button at the top right. "My Z-Index" will 
appear. Click the G-Standaard Invoerloket link. The G-Standaard data entry web 
portal opens with a product overview. Your products are presented as articles. 

 

 

 

 

 

 

 

 

 

 

 

 

After logged in in the G-Standaard Data Entry Web Portal, click on the right mouse 
button on a white space on the screen and select ”Vertalen in het Engels” (Translate 
to English). The G-Standaard data entry web portal will be translated. Note that the 
terminology may differ! 

You can browse through your articles, apply filters to the overview or search for a 
specific article. You can also add, submit and delete articles from this article 
overview. You will see a warning if you have yet to submit edited articles. 
Functionality on the 'Up-/Download' tab is discussed in part 2. On the 'Notifications' 
tab you will see your contact details and you will receive additional information 
about changes still to be submitted. 

Detailed explanation about the G-Standaard data entry web portal can be found via 
the button at the bottom right of the article overview.  Help 



Statuses 
Each article has a status (see the "Status" column in the article overview). These 
statuses determine whether a given field can be modified and whether articles can 
be deleted. The statuses are: 
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Draft 
A new article that has yet to be submitted to Z-Index. All 
fields are open for changes. The article can be submitted or 
deleted. 

New submitted The article has been submitted to Z-Index. All fields are 
locked. Z-Index can approve it or reject it. 

New rejected 
The article has been rejected. Z-Index will get in touch. All 
fields are open again. The article can be submitted again or 
deleted. 

New approved 
An approved article that will be published on the  
G-Standaard when the "On the market from" date comes. 
Some fields can be modified. 

New modified 
A new article that has not been published on the  
G-Standaard yet has been modified. The changes have yet 
to be submitted to Z-Index. 

New submitted with 
modifications 

A new article that has not been published on the 
 G-Standaard yet has been modified and submitted to  
Z-Index. All fields are locked. 

   

P
re

vi
ou

sl
y 

pu
bl

is
he

d 
ar

ti
cl

es
 

Published The article is published on the G-Standaard when the "On 
the market from" dates comes. Some fields can be modified. 

Modified 
An article that has previously been published on the  
G-Standaard has been modified. The change has yet to be 
submitted to Z-Index. 

Submitted with 
modifications 

An article that has previously been published on the  
G-Standaard has been modified and submitted to Z-Index. 
All fields are locked. 

Approved with 
modifications 

The changes have been approved and will be included in 
the next G-Standaard. Some fields can be modified. 

Expired The provided expiry date has already passed. The article is 
no longer published on the G-Standaard. 



Filling in the article fields. 

Linking packaging GTINs. 

Linking additional information. 

Submitting the new article to Z-Index. 

 

 

 

This section discusses the entry and modification of articles, starting with the entry 
of a new article. This consists of four steps: 

 

 

  

 
 

 

Filling in the article fields. 

Click the "Add" button under the article overview. A new article will appear. All fields 
except “ZI-number” and "Tradable from" are empty. The status is "Concept". The 
table with linked GTINs in the block "Packaging" and the table with extra information 
in the block "Linked documents" are also still empty. At “History” only the date entry 
is shown. 
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Part 1: Article maintenance 



Click        to see a description of the fields. Fields marked with an asterisk are 
required fields. Your additions will be checked straight away. A red error notification 

will appear if something goes wrong. 

Click the "Check" button at the bottom of the screen after filling in the field. No more 
error notifications should appear. Step 1 is done. 
 

Linking packaging GTINs 

In the 'Packaging' block, one or more different types of packaging, each with a 
unique GTIN, can be linked to an article with a unique ZI number. The packaging 
types are: unit dose, consumer pack and outer box.  

 

 

 

 

 

 

 

 

 

 

 

Possible variations of the depicted packaging hierarchy are: 

• Multiple consumer packages (with unique GTINs) with the same ZI-number, 
e.g. with parallel import, 

• Multiple smallest delivery units packed by multiple consumer packages with 
the same ZI-number, 

• A smallest delivery unit packed by several consumer packages with different  
ZI- numbers, 

• An outer box that can be reimbursed with its own ZI-number. 
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GTIN for scanning and logistics. 
ZI number for: pharmacovigilance, 
reimbursement and logistics. 

GTIN for scanning and logistics. 
No specific ZI number: pharmacovigilance 
via the consumer pack,  
no reimbursement of individual 
pills/ampoules.   

Consumer pack: 
Secondary packaging for:  
• pharmacy  
• pharmacist 
• hospitals 

Outer box: 
Tertiary packaging for:  
• pharmacy  
• pharmacist 
• hospitals 

GTIN for scanning and logistics. 
No specific ZI number. 

Unit dose: 
Primary packaging/EAG/single 
unit dose for:  
• hospitals 



The potential variations of the displayed packaging hierarchy are described in  
§ 2.2 and 2.3 of the comprehensive user guide.   

Click the "Add consumer packaging" button.  The consumer pack screen appears, still 
empty: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Enter the unique GTIN displayed on the box in the "GTIN" field. Check the "Name on 
the packaging". Enter a distinctive feature (where applicable). The "Tradable from" of 
the article appears as the start date. Enter the dimensions (where available). 

Click "Save and quit". The consumer pack appears in the packaging table beneath the 
article fields. The closed chain icon      in front of the row indicates that this 
consumer pack has a direct link with this ZI number. 

You should only take the next step if the unit dose in the consumer pack 
(e.g. an ampoule or an individual pocket or blister) has its own unique 
GTIN printed on it. 



Click the "Add smallest delivery unit" button. Enter the unique GTIN printed on the 
unit dose. Check the "Name on the packaging". Enter a distinctive feature (where 
applicable). Enter the dimensions (where available). Click "Save and quit". 

The unit dose has yet to be linked to the consumer pack: a broken chain icon  
appears in front of the row. Click the orange GTIN of the consumer pack (not the 
GTIN of the unit dose!). The consumer pack fields come back on-screen. Click the 
drop-down menu of the field "Packaging contains": 

 

 

 

Select the row with the GTIN of the unit dose. Fill in the field "Number". Click "Save 
and quit". 

The packaging table beneath the article fields now shows that the consumer pack 
contains the unit dose as well as the number. See the columns "Packaging", 
"Packaging contains" and "Number". 
 

You should only take the next step if one or more consumer packs are 
packaged in an outer box that has its own unique GTIN. 

Click the "Add outer box" button. Enter the unique GTIN printed on the outer box. 
Check the "Name on the packaging". Enter a distinctive feature (where applicable). 
Click the drop-down menu of the field "Packaging contains" and select the row with 
the GTIN of the consumer pack. Fill in the field "Number". Enter the dimensions 
(where available). Click "Save and quit". 

You have now added a new article and linked it to three packaging GTINs 
(corresponding to the unit dose, a consumer pack with a direct ZI number link and an 
outer box) and checked their consistency:  

 

 

 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to, you can add multiple packagings of different kinds. After that, Step 2 
is done. 
 

Linking additional information. 

Under the block "Packaging" you will see the block "Linked documents". Here you 
can link documents such as registration sheets, SmPCs, mockups, images or photos 
of the packaging to new articles. The more information you link to the new article 
that clarifies the product properties, the more efficient the handling by Z-Index can 
be.  
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Click on the button “Link document” (only visible for articles with the status Draft or 
New rejected), fill in the description of the document, click on the button “Select and 
link document”, browse on your PC to the correct document and click on “Open”. If 
desired, link more documents in the same way. 

Click on the document or the download icon to transfer the document to your PC. 
Click on the edit icon to edit the description or on the trash can to delete the 
document. 

You can link 10 documents of a maximum of 50 Mb per new article. Z-Index can also 
link documents to articles, which you will see in the same table in the Linked 
documents block. Linked documents are not disclosed to G-Standaard customers but 
remain with Z-Index. 

Click the "Check" button to make sure. If no error notifications appear, click "Save".  
Click    Articles    in the orange menu bar under the Z-Index logo. The article 
overview appears. 

To make further changes before submitting the article, search for it from the article 
overview and click the orange description. After making the changes, click "Save" 
again. 

Step 3 is done. Finally, you have to submit the new article to Z-Index. 

If you no longer want to submit the new article, click the ZI-number of the 
new article (not the orange article name) in the article overview. The row is 
now selected and    shaded in dark grey   .  Click "Delete". 

 

 

 

 



Submitting the new article to Z-Index 

Search for the new article in the article overview and click the ZI-number (not the 
orange article name). The row is now selected and    shaded in dark grey   . Click 
"Submit". The status changes to "New submitted". All fields are locked for the time 
being. 

Z-Index now runs a series of checks, makes the article available on the G-Standaard 
as required and, where applicable, links information such as pharmacovigilance or 
reimbursement information: 

• If everything is in order, Z-Index switches its status to "New approved".  You 
will receive an e-mail with this information. If necessary, some fields can still be 
modified. 

• If corrections need to be made, Z-Index switches its status to "New rejected".  
Z-Index will get in touch. All fields can be changed again. 

Step 4 is done. When the "On the market from" date comes, the article will be 
published on the G-Standaard. When this happens, the status changes automatically 
from "New approved" to "Published". 

New articles must be submitted to Z-Index, otherwise they will not be 
included in the G Standaard and therefore will not be known to the 
customers. You will see a notification above the article overview about this 
and explanation on the tab 'Notifications'. 

 

Modifying existing articles 
In order to modify existing articles, search for them in the article overview and click 
the orange description. Depending on the status of the article, you can:  

• change all the fields (statuses "Draft" and "New rejected");  
• change no fields at all (statuses "New", "New submitted with modifications" and 

"Submitted with modifications");  
• change some fields (remaining statuses). 

Click the "Check" button after making the changes. If no error notifications appear, 
click "Save". Click    Articles    in the orange menu bar under the Z-Index logo. The 
article overview appears. Search for the article and click its row (on the ZI-number or 
any other place except the orange article name). The row is now selected and  
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    shaded in dark grey    .  Click "Submit" under the article overview. You can select 
and submit multiple articles at the same time. 

Remember to submit the modified articles! Otherwise, they will not be 
taken into account on the G-Standaard. Every Friday you will receive an 
automatic e-mail with all the modifications and article drafts that are 

outstanding (i.e. pending submission). You will see a notification above the article 
overview about this and explanation on the tab 'Notifications'. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Checking the digit-grouping symbol, list-separator character and date format. 

Downloading the article file and adding/changing products locally. 

Uploading the article file with new/modified products. 

Submitting the modifications. 

 

 

If you want to enter or change larger numbers of items at the same time, you can do 
so using the Up/Download functionality. For this, the following steps must be 
followed: 

 

  

  

  

 

 

Checking decimal symbol, digit-grouping symbol, list separator and date 
format  
Click on the Windows start button  and type in directly: intl.cpl and press 
Enter. Click on Additional settings. Adjust the settings of the fields as shown in the 
picture below. Save the changes you made. 

Check this carefully. This step is crucial to using the upload/download feature 
successfully. Check this every time you use the upload/download feature. 
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Semicolon 

Part 2: Up-/Download  
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Then click on the 'Date' tab at the top. The following window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the mouse in the Short Date Format field.  
So don't use the drop-down menu! Now type:  

dd-MM-yyyy  

So days and months with two characters, - as a separator and four-digit years 

Click "OK" twice to close the screens. 

You are now ready to start using the Up-/Download functionality of the G-Standaard 
data entry web portal. 

 

 

 

 

 

 

 



Downloading the article file and adding/changing articles locally. 

You are about to download a .csv file. Do not open this .csv file directly in 
Excel as it could lead to the disappearance of leading zeros. Always use the 
Excel text import wizard. 

Click    Up-/Download    in the orange menu bar on the G-Standaard Data Entry Web 
Portal and then       . The CSV file with the articles is saved on your 
computer (so do not open directly!) with a name including your company name, GLN 
code, the date/time and "A" for artikelen ("articles"). 

In Excel 365/2019, the Import Text Wizard needs to be turned on once.  
Click File > Options in the menu bar on the left > Data in the menu bar on the left > 
select "From Text (Legacy). Click OK. 

Start the Import Text Wizard 
In Excel 365/2019: click Data -> Get data -> Legacy Wizards -> From Text (Legacy). 

In Excel 2016 and earlier versions, click Data -> Get Data or Get External Data and 
then From text. 

After launching the Import Text Wizard, open the article file you just downloaded. 
 

Import Text Wizard, Step 1 of 3 
Delimited is checked. Click Next. 
 
Import Text Wizard, Step 2 of 3 

 

 

 

 

 

 

 

 

 

Remove the check mark from Tab and check the box Semicolon. Click Next. 

 

Download Articles 
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Import Text Wizard, Step 3 of 3 
Click "Advanced" and check the decimal separator and the thousands separator. 

 

 

 

 

 

 

 

Click OK. Go to the “manufacturer HIBC” column using the horizontal scroll bar and 
click exactly manufacturer HIBC. The column turns black. Select “Text” from the Data 
type to set the column format to text.  

 

 

 

 

  

 

 

 

 

Text now appears at the top of the “Manufacturer HIBC” column. Repeat the same 
steps for: 

• Z-Index HIBC;  
• manufacturer article code; 
• RVG/RVH number; and 
• European registration number. 

Click “Finish” and then “OK”. The file with your articles is now loaded into Excel.  

You can now take the two following actions: changing existing articles or adding new 
ones based on an existing article. 
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Modifying existing articles 
Search for the articles to be modified one by one and change them as wished. 
Depending on the status of the article, you can:  

• change all the fields (statuses “Draft” and “New rejected”);  
• change no fields at all (statuses “New submitted”,  New submitted with 

modifications” and “Submitted with modifications”); or 
• change some fields (remaining statuses). 

 

Adding new articles based on an existing article 
Search for the article on which you want to base the new article and copy-paste that 
entire row as a new row. Now delete the ZI number in the first cell of that copied 
line, because you will be assigned a new ZI number later. Adjust the name of the 
article and, if necessary, change its purchase price, sales price, manufacturer article 
code and RVG/RVH number. Set the "On the market from" date to the next (or a 
later) G-Standaard production month (always the first of the month). Check all the 
fields in the row of the new article carefully again. 

So you can combine modifications to existing articles and additions of new ones on 
the same worksheet.  

Once you are done, save the new worksheet with the modifications and any new 
articles as a comma-separated values (CSV) file (*.csv). 

 

 

 

Step 2 is done. 

 

 

 

 

 

 

 

 



Uploading the article file with new/modified articles 

Click op    Up-/Download    in the orange menu bar on the G-Standaard Data Entry 
Web Portal and then        . Search for the CSV file with 
modifications/additions that you created in Step 2 and click Open. The file is 
submitted and processed straight away: 

• A   green notification   at the top right means that the file has been processed 
successfully. 

• A   red notification  means that something has gone wrong.  

In both cases, you will receive an e-mail with the processing results. The file that you 
uploaded and a CSV file with the processing results will be attached to this e-mail for 
reference. The name of this CSV file ends in –report.csv.  

Read the processing report carefully. Check whether the 
modifications/additions that you uploaded are also present in the report. 

If the processing failed, correct the errors outlined in the e-mail and try again. The 
row number in the Excel file that contains the error is displayed at the front. 

  

Submitting the modifications 

The modified articles (with the “Modified” status) and new articles (with the “Draft” 
status) are also in the article overview. Now, you need to submit these articles.  

Filter the article overview by status Modified. All modified articles are now displayed 
in the overview. Select the number of rows to make sure that you see all 
changes and click "Select all rows" . The rows are now selected and 
  shaded in dark grey  . Click Submit under the article overview. Repeat these steps if 
you have more than 500 modifications and for new articles with the Draft status 
(filter the article overview by status Draft). 

Remember to submit all the modified and new articles! Otherwise, the 
changes and/or additions will not be taken into account on the G-Standaard. 
You will see a notification about this above the article overview and an 

overview on the 'Notifications' tab. And every Friday you will receive an automatic e-
mail with all the modifications and article drafts that are outstanding. 
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Modifying/adding article packagings with the Upload/Download feature 

In a similar way as described earlier, you can use the Upload/Download feature to 
modify packagings and add new ones. Refer to § 8.3 of the G-Standaard Data Entry 
Web Portal User Guide via the button               at the bottom right of the article 
overview or via  www.z-index.nl > Documentation > User guides.  
 
Do you need help with the operation of the G-Standaard data entry web portal, 
contact Z-Index on 070-37 37 437 or info@z-index.nl. 
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Intermediary in healthcare product information 

 

Supports the prescription, 
delivery, ordering, declaration and 
reimbursement of care products. 
Contains relevant data on care 
products available in pharmacies 
and healthcare institutions. 
Used by all community, hospital, 
polyclinic and outpatient 
pharmacists, general practitioners, 
medical specialists and health 
insurance companies in the 
Netherlands. 

G-Standaard in 3 points 

Z-Index 
Alexanderstraat 11 
2514JL Den Haag 
T +31(0)70 37 37 437 
E info@z-index.nl 
W www.z-index.nl 

info@z-index.nl 
Website www.z-
index.nl 


